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All product names, logos, and trademarks referred to in this document shall belong to their

owners.

The trademarks «МойОфис» and MyOffice belong to New Cloud Technologies Ltd.

Nothing in these terms shall be construed under any circumstances as direct or indirect

provision of a license or right to use the trademarks, logos or service marks used herein.

Any unauthorized use of these trademarks, logos or service marks without the written permission

of their owner is strictly prohibited.
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LIST OF ABBREVIATIONS

The abbreviations used in this document are given in the Table 1.

Table 1. Abbreviations and definitions

Abbreviation Definition

OS Operating system

MyOffice software MyOffice Text, MyOffice Spreadsheet, MyOffice Presentation applications
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1 GENERAL INFORMATION

1.1 About

This guide describes the steps for installing, updating, configuring and uninstalling the

following desktop applications under Linux and Windows operating systems:

– MyOffice Text is an editor for fast and convenient creation and formatting of text

documents of any complexity.

– MyOffice Spreadsheet is an editor for creating spreadsheets, conducting calculations,

analyzing data, generating summary reports, and automating data processing using

macros.

– MyOffice Presentation is an application for creating, designing, and displaying

presentations.

A detailed description of the features of these applications can be found in the MyOf f ice

Education. Feature list document.
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1.2 System requirements

Product

(software

installer)

Hardware requirements

Software requirements
Minimal Recommended

MyOffice

Education

Desktop Editors

for Windows

(64-bit)

– Processor: 1 GHz 

x86-64

– Memory: 2GB

RAM

– Hard disk: 3GB of

available disk space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor: 2 GHz or

faster x86-64 processor

– Memory: 3GB RAM or

more

– Hard disk: 5GB of

available disk space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Microsoft Windows 7 

(64-bit)

– Microsoft Windows 8.1

(64-bit)

– Microsoft Windows 10

(64-bit)

– Microsoft Windows 11

(64-bit)

MyOffice

Education

Desktop Editors

for Linux 

(64-bit)

– Processor: 1 GHz 

x86-64

– Memory: 2GB

RAM

– Hard disk: 3GB of

available disk space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor: 2 GHz or

faster x86-64 processor

– Memory: 3GB RAM or

more

– Hard disk: 5GB of

available disk space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Alt Workstation 10.0 (64-bit)

– Alt Workstation K 10.0 (64-bit)

– Alt Education 9 (64-bit)

– Alt Education 10 (64-bit)

– ROSA Chrome

Workstation 12 (64-bit)

– ROSA COBALT

Workstation 7.9 (64-bit)
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Product

(software

installer)

Hardware requirements

Software requirements
Minimal Recommended

Presentation

Editor

for Windows

(64-bit)

– Processor: 1 GHz 

x86-64

– Memory: 256Mb

RAM

– Hard disk: 1.55GB

of available disk

space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor: 2 GHz or

faster x86-64 processor

– Memory: 512Mb RAM

or more

– Hard disk: 2GB or

more of available disk

space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Microsoft Windows 7 

(64-bit)*

– Microsoft Windows 8.1

(64-bit)*

– Microsoft Windows 10

(64-bit)

– Microsoft Windows 11

(64-bit)

*Bef ore installing the Presentation Editor application, make sure that the f ollowing updates are installed
in your OS:

– Microsof t Windows 7 (64-bit) – Update KB2999226;

– Microsof t Windows 8.1 (64-bit) – Update KB2919355.

Presentation

Editor

for Linux,

rpm-based 

(64-bit)

– Processor: 1 GHz

x86-64

– Memory: 256Mb

RAM

– Hard disk: 1.55GB

of available disk

space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor: 2 GHz or

faster x86-64 processor

– Memory: 512Mb RAM

or more

– Hard disk: 2GB or

more of available disk

space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Alt 8 SP Workstation (64-bit)

– Alt Workstation 9.2 (64-bit)

– Alt Workstation K 9.2 (64-bit)

– Alt Workstation 10.1 (64-bit)

– Alt Workstation K 10.1 (64-bit)

– Alt Education 9.2 (64-bit)

– Alt Education K 9.2 (64-bit)

– Alt Education 10.1 (64-bit)

– Alt Education K 10.1 (64-bit)

Presentation

Editor

for Linux,

deb-based 

(64-bit)

– Processor: 1 GHz

x86-64

– Memory: 256Mb

RAM

– Hard disk: 1.55GB

of available disk

space

– Processor: 2 GHz or

faster x86-64 processor

– Memory: 512Mb RAM

or more

– Hard disk: 2GB or

more of available disk

space

– Astra Linux Special Edition 

release Oryol 1.7

(64-bit)

– Astra Linux Special Edition

release Voronezh 1.7

(64-bit)



8

© New Cloud Technologies Ltd., 2013–2024 8

Product

(software

installer)

Hardware requirements

Software requirements
Minimal Recommended

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Astra Linux Special Edition 

release Smolensk 1.7

(64-bit)

Presentation

Editor

for Linux,

deb-based

(64-bit),

Oryol 

– Processor: 1 GHz

x86-64

– Memory: 256Mb

RAM

– Hard disk: 1.55GB

of available disk

space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor: 2 GHz or

faster x86-64 processor

– Memory: 512Mb RAM

or more

– Hard disk: 2GB or

more of available disk

space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Astra Linux Common Edition

release Oryol 2.12 

(64-bit)

– Astra Linux Special Edition 

release Smolensk 1.6

(64-bit)
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1.3 Limitations

Supported interface languages:

– English

– French

– Russian

When installing the MyOffice software, the application interface language is defined:

– In Windows OS: by the regional format.

– In Linux OS: by the main language of the OS interface.
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2 INSTALL AND UPDATE

2.1 Software installers

You can find the list of MyOffice software installers in Table 2.

Table 2. List of MyOffice software installers

OS Software installers

Windows MyOffice_Education_Documents_Win_3.1.0_х86_64.msi

Linux 1. myoffice-education-documents_3.1.0_x86_64.rpm

2. myoffice-education-documents_3.1.0_amd64.deb

2.2 Install on Windows OS

To install MyOffice software on Windows OS, place the distribution kit in a local folder

and start its execution by double-clicking.

If Windows prompts you to confirm the installation, enter the OS administrator password.

In the welcome window of the Setup Wizard (see Figure 1), click Next.

Figure 1. Setup Wizard welcome window
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In the Destination Folder window (see Figure 2), specify the folder where you want

to install MyOffice applications or keep the default folder.

To go to the next window, click Next.

Figure 2. Destination Folder window

In the Ready to install MyOffice Education window (see Figure 3), click Install.

Figure 3. Ready to setup MyOffice Education window
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Wait until all the components of MyOffice are installed (see Figure 4).

Figure 4. MyOffice Education Setup window

In the Completed MyOffice Education Setup Wizard window (see Figure 5), click

Finish.

Figure 5. Completed MyOffice Education Setup Wizard window
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2.3 Update on Windows OS

To update MyOffice software, use the window shown in Figure 7.

If MyOffice Standard software is set to auto-update (for more details see Section 2 of

MyOffice Text. User Guide, MyOffice Spreadsheet. User Guide or MyOffice Presentation. User

Guide), then when a new version of the product is released, this window opens automatically

while working in the applications.

If auto-update is not configured, this window can be opened manually. To do this, select

Help > Check for Updates from the Command menu in MyOffice Text, MyOffice Spreadsheet or

MyOffice Presentation application (see Figure 6).

Figure 6. Check for Updates Command menu option

To download and install the new version, click Install (see Figure 7).
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Figure 7. Window with information on new version

Wait for the new version of the product to be downloaded to your computer (see Figure 8).

Figure 8. Application Update window

In the Application Update window (see Figure 9), click Install.
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Figure 9. Ready to Install window

The welcome dialog box of MyOffice software setup wizard will open.

Close MyOffice Text, MyOffice Spreadsheet and MyOffice Presentation applications and

follow the steps described in the Install on Windows OS section.
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2.4 Install and update on Linux OS

The installation and update of MyOffice software on Linux is done using a pre-installed

program with a graphical interface designed to install rpm or deb packages. To install or update

MyOffice software, you must have an administrator password.

In this example, MyOffice software will be installed (updated) in the Alt Education 10.1

operating system.

To install or update the software, follow these steps:

1. Place the MyOffice rpm package MyOffice suite the local folder.

2. Double-click with the mouse to run the file.

3. In the Install RPM window, click Install (see Figure 10).

Figure 10. Install RPM window
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4. In the log in window, specify the administrator password and click OK (see Figure 11).

Figure 11. Log in window

5. Wait until the package installation/update is complete and click Exit (see Figure 12).

Figure 12. Package installation complete
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3 VERIFY SUCCESSFUL INSTALLATION

3.1 Verify successful installation on Windows OS

If you installed MyOffice applications on Windows OS and you see the shortcuts shown on

Figure 13 and in the main menu of the OS (see Figure 14) and, when clicked, the corresponding

applications open correctly without any error messages, that means you have successfully

installed MyOffice software.

Figure 13. MyOffice applications Windows OS desktop shortcuts

Figure 14. MyOffice application shortcuts in the Windows main menu
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3.2 Verify successful installation on Linux OS

If you installed MyOffice applications on Linux OS, the shortcuts are displayed in the OS

Application menu (see Figure 15), and the respective applications are launched without any error

messages, that means you have successfully installed MyOffice software.

Figure 15. MyOffice applications Linux OS desktop shortcuts
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4 CONFIGURATION

You can open the files you are working on in other text or spreadsheet editors directly from

MyOffice Spreadsheet or MyOffice Text. To select the application that you want to use, click

File > Open With option (see Figure 16).

The list of programs available for selection is customizable using the OpenWithList.ini

file. If this file does not contain data or contains incorrect data, the File > Open With option is

not displayed in the Command menu.

Figure 16. Open With command
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To add, change, or delete a program from the list, follow these steps:

1. Run a text editor installed in the OS as an administrator (for example, Notepad in

Windows OS).

2. In a text editor, open the file <installation folder> > Resources > OpenWithList.ini.

file, where <installation folder> is the installation folder for MyOffice software.

3. Change the file as needed. Keep the following data structure in the file

(see the example below):

– [section name] is an application in MyOffice softwarefor which the list is created:

· [MyOffice Text] is MyOffice Text application.

· [MyOffice Spreadsheet] is MyOffice Spreadsheet application.

– [ordinal number\AppPath] where:

· sequence number is the application sequence number in the list.

· appPath is the full path to the executable file of the program. The path should

appear in quotation marks. In Windows, directory names should be separated using

a slash (/) or a double backslash (\\) when specifying the path to a file.

– [serial number\appTitle] where:

· sequence number is the application sequence number in the list.

· appTitle is the short name under which the program will be displayed in the list.

The name should appear in quotation marks. If the name of the application is not

specified in the configuration file, the list will display the title of its executable file

without extension.

4. Save the file in UTF-8 format.

5. Restart the application to see the changes made.

Example of OpenWithList.ini file:

[MyOffice Text]
1\appPath="C:/Program Files/LibreOffice/program/swriter.exe"
1\appTitle="LibreOffice Writer"
2\appPath="C:\\Program Files\\Microsoft Office 15\\root\\Office15\\WINWORD.EXE"
2\appTitle="Word"

[MyOffice Spreadsheet]
1\appPath="C:/Program Files/LibreOffice/program/scalc.exe"
1\appTitle="LibreOffice Calc"
2\appPath="C:\\Program Files\\Microsoft Office 15\\root\\Office15\\EXCEL.EXE"
2\appTitle="Excel"
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5 UNINSTALL

5.1 Uninstall the software on Windows OS

Before uninstalling, close all applications from the MyOffice suite.

You can uninstall MyOffice software using the Windows main menu or control panel.

Here's an example of how to uninstall the applications in Windows 10.

To uninstall MyOffice software using the Windows main menu, follow the steps below:

1. Open the Start menu in Windows OS.

2. Scroll down the list of installed applications until you reach the letter M.

3. Expand the MyOffice Education folder (see Figure 17).

Figure 17. MyOffice Education folder
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4. Select Uninstall MyOffice Education (see Figure 18).

Figure 18. Running the Windows Installer

5. In the Windows Installer dialog box, click Yes (see Figure 19).

Figure 19. Windows Installer dialog box

6. Wait until all MyOffice software components are uninstalled (see Figure 20).

Figure 20. Uninstall components
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To uninstall the MyOffice software using the Windows Control Panel, follow the steps

below:

1. Open the Control Panel.

2. In the Control Panel window, select Programs and Features.

3. In the list of programs and features, select MyOffice Education and click Uninstall

(see Figure 21).

Figure 21. Uninstall or change a program window

4. In the Programs and Features dialog box, click Yes (see Figure 22).

Figure 22. Programs and Features dialog box

5. Wait until all MyOffice software components are uninstalled (see Figure 20).
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5.2 Uninstall the software on Linux OS

Before uninstalling, close all applications from the MyOffice suite.

You can uninstall the MyOffice software on Linux OS using the pre-installed GUI program

for package management. To uninstall the software, you are required to have an administrator

password.

Here's an example of an uninstall using Synaptic software on the Alt Education 10.1 OS.

To uninstall MyOffice software, follow the steps below:

1. Launch the Synaptic software.

2. In the login window, enter the administrator password.

3. In the Synaptic software window, in the list on the left, select the Applications/Editors

section (see Figure 23).

4. In the list on the right, select the myoffice-education package.

5. Open the context menu of the package by right-clicking and run the Mark for Removal

command.

Figure 23. Select a package to be deleted
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6. Click Apply (see Figure 24).

Figure 24. Confirmation of operation selection

7. In the Summary window, click Apply (see Figure 25).

Figure 25. Summary window
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8. In the Package Manager output window, click Close (see Figure 26).

Figure 26. Package Manager output window

9. Close the Synaptic software.
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